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Ivadas

Si mokomoji medziaga skirta asmenims, siekiantiems i¥mokti naudotis Microsoft Outlook
2000 programa. Ji skirta nedidelés apimties programos kursui: iki 10 akademiniy valandy.

MS Outlook padés raSyti, skaityti, siysti elektroninius laiSkus, juos i$saugoti, spausdinti ir
kt.. Si programa skirta verslininkams, kuriy darby apimtys yra didelés, reikia nuolat derinti
uzduotis, susitikimus su kolegomis ar verslo partneriais. Tuomet, MS Outlook ir neSiojamas
kompiuteris taps nepakei¢iamais jo talkininkais.

Paskaity konspektas padés iSmokti organizuoti savo darbo grafika ir apsikeisti informacija
su kitais vartotojais Microsoft Outlook programos pagalba. Konspekte medziaga pateikta
metodiskai: nuo paprasty aplankuy pildymo iki naudojimo Intranet tinkle. Sios programos
mokymasis glaudziai siejasi su praktiniu darbu, t.y. iSbandant Sios programos galimybes, vykdoma

praktiné veikla kompiuteriu. Todél papildomos uzduotys Siame apra§yme nepateikiamos.

Pagarbiai Fausta Melninkiené



1. Supazindinimas su Outlook

Microsoft Outlook - tai programa, skirta informacijai tvarkyti ir asmeniniams darbams
planuotieji padeda sekti visa informacija bendrauti su iSoriniu pasauliu - arba vietiniame tinkle, arba
per Interneta.

Su Outlook galima atlikti Stai ka:

» Tvarkyti asmening ir su verslu susijusia informacija, kaip antai el. pasta, susitikimus,
adresatus, uzduoCiy saraSus, nedideles pastabas lipdukuose ir failus, taip pat perzitiréti jvairias
apzvalgas apie tai, kaip praleistas jiisy laikas.

* Dalytis duomenimis su asmeny grupe, el. pastu, pasitelkiant grupiu planavima,
bendruosius aplankus ir kt.

* Dalytis duomenimis sujotomis Office programomis ir itraukti { Office dokumenty sarasa
bei paieska tiesiai i§ programos.

» Susisiekti su kitais per Interneta.

+ Plétoti vartotojo apibréztus sprendimus, pasitelkiant jvairias programavimo priemones.
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1 pav. Atidarius Outlook, rodomas programos turinys. Kairé¢je matote Qutlook nuorody
juosta, 18 kurios visada pasieksite kitas programos dalis.

Pavadinimo juosta

Visose Windows programose yra pavadinimo juosta, kurioje rodomas programos
pavadinimas ir keli valdymo mygtukai skirti lango dydziui, padéciai ir pan. keisti.
Meniu juosta

Sioje juostoje yra pagrindinis Outlook meniu, joje tikriausiai atpaZinsite keleta elementy,
bendry visoms Microsoft programoms. Dabartiné meniu juosta sukurta kaip irankiy juosta, kurig
galima keisti ir kilnoti taip, kaip paaiSkinta kitame skyrelyje apie irankiu juostas (tacCiau jos
negalima paslépti). Meniu juostos turinys kinta priklausomai nuo informacijos, su kuria dirbate,
tipo.

[rankiy juostos

[ jrankiy juosta sudéti mygtukai, panasiis | kai kuriuos programos meniu punktus. Galima
iSkelti | ekrang kitas irankiy juostas arba sukurti savo.

Standartingje irankiy juostoje yra dazniausiai naudojami jrankiai. [rankiy juostos turinys
keiciasi priklausomai nuo informacijos, su kuria dirbate, tipo. DeSiniuoju pelés mygtuku baksteléjus
irankiy juosta, galima pasirinkti jrankiy juostas Advanced ir Web. Irankiy juostos Advanced turinys
taip pat keiCiasi, atsizvelgiant | informacijos tipa. [rankiy juosta Web atsiranda automatiskai, kai
informacijos lange atveriamas tinklapis.



Darbas su Outlook

Kad darbas programa Outlook buty efektyvesnis, turite sugebéti lengvai ir greitai rasti
reikiama informacija. Atskiri elementai (tokie kaip praneSimai, susitikimai, uzduotys, lipdukai ir
t.t.) raSomi { skirtingus. Outlook aplankus.

Kompiuteryje diegiant Outlook, daugybé $iu aplanky nuorodu bus automatiskai jdiegtos i
Outlook nuorody juosta, kuri rodoma programos lango kairéje. Sios nuorodos suskirstytos { tris
grupes: Outlook Shortcuts (Outlook nuorodos), My Shortcuts (Mano nuorodos) ir Other Shortcuts
(Kitos nuorodos). Galima pridéti ir savo grupes bei nuorodas.

1.1 Lentele
Outlook juostos grupés ir nuorodos.
Grupé Nuorodos ApibréZimas
Outlook Outlook  Today (Outlook|Pateikiama dienos apzvalga: rodomi S§ios
Shortcuts Siandien) dienos susitikimai ir uzduotys bei neskaityty
praneSimu skaicius.
Inbox (Gaunamas pastas) Cia laikomi gauti pranesimai.
Calendar (Kalendorius) Atveriamas kalendorius, kuriame galima
matyti susitikimus, susirinkimus ir t.t.
Contacts (Adresatai) Cia laikomi asmeny bei jstaigy, su kuriomis

dirbate ir bendraujate, pavardés, vardai,
adresai, telefonai ir t.t.

Tasks (Uzduotys) Ivairiy uzduociy sarasai.

Notes (Lipdukai) Cia laikomi elektroniniai lipdukai su
ivairiomis nastahomis

Deleted  Items  (Panaikinti|Cia laikinai laikomi panaikinti elementai
elementai) pries$ juos iStrinant visiskai.

My Shortcuts Drafts (Juodrasciai) Tai dar nebaigti, neiSsiysti pranesSimai,
uzduotys ir pan.

Outbox (Stun¢iamas pastas) Cia laikomas el. pastas prie§ issiunéiant

gavejui.
Sent mail (I8siustas pastas) Cia iraSomos issiusto el. kopiios
Journal (Zurnalas) Cia kaupiama visos veiklos apZzvalga

(automatiskai sudaroma).

Outlook  Update  (Outlook|1$ €ia galima prieiti prie Qutlook naujinimo
naujinimas) srities Outlook Update, nuolatos naujinamo
tinklapio, kuriame suteikiama informacija ir

Other Shortcuts |My Computer (Mano|I§ c¢ia galima pasiekti kitus kompiuterio
komniuteris) diskus. anlankus ir failus.
Documents (Dokumentai) Tai nuoroda aplanko, kuriame laikomi

Office programomis sukurti failai, pvz.,
Microsoft Excel arba Word.
Favorites (Parankiniai) Cia laikomos parankiniy aplanky ir
Internete adresy nuorodos




Persijungimas tarp aplanky

Tarp skirtingy grupés aplanky persijunkite taip:
Paméginkite baksteléti kalendoriaus piktograma, kad pereituméte i kalendoriy, kuriame matysite
savo susitikimy, susirinkimy ir t.t. apzvalga.
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2 pav. Dienotvarké programoje Outlook
1. Bakstel¢jus maza rodyklyte deSinéje vir§ grupés My Shortcuts mygtuko, bus parodytos
kitos grupés Outlook nuorody piktogramos.
2. Bakstel¢je piktograma Noteés (Lipdukai), pamatysite savo elektroniniy lipduky sarasa .
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3 Items

3 pav. Notes lange rodomas elektroniniy lipduky, kuriuos sukiiréte, saraSas

Persijungimas tarp nuorody grupiy

Tarp skirtingy nuorodu grupiy galima persijungti taip:

1. Bakstelékite, pvz., mygtuka Other Shortcuts (Kitos nuorodos) ir pereisite i Sig aplanky ir
piktogramy grupe. Dabar Sios grupés piktogramos rodomos Outlook juostoje, taCiau informacijos
lange matysite lipduky saraSa, nes dar nebakstel¢jote jokios piktogramos naujoje grupéje.

2. Baksteléjus piktograma My Computer, pasirodys jusuy arba kity kompiuteriu kietyju
disky ir t.t. sarasas.



Kaip kurti elektroninius lipdukus

1. Pazymeékite grupe Outlook Shortcuts (Outlook nuorodos), jeigu to dar nepadaréte, ir
bakstelékite piktograma Notés (Lipdukai). Dabar mygtukas New nustatytas kurti lipdukus.

2. [rankiy juostoje baksteléjg mygtuka New, ekrane pamatysite nauja tuscia lipduka.

3. Irasykite teksta ,,Neuzmirsti duonos rytdienos patiekalui!" ir, jeigu reikia, prateskite,
kaip matote pavyzdyje.

Z I
MeuZmirgti duonos
rytdienas patiekaluil

14 bandeliy,
7 pyrago gabaléliai,
syigstas ir sdris

2002.01.17 1735
4 pav. Elektroninis Outlook lipdukas.

4. VirSutiniame deSiniajame lipduko kampe bakstelékite mygtuka Close (Uzdaryti).
Dabar jiisy lipdukas rodomas kaip piktograma perziiiros lange.

Ivairis rodiniai
Savo duomenis galima rodyti skirtingai. Taigi kalendoriuje galite rinktis dienos, savaités,
ménesio rodinius ir kitokius informacijos pateikimo buidus.

Tarp skirtingy rodiniy persijungiama iprastomis meniu komandomis arba su {vairiomis
slinkties juostomis bei jrankiy juostos mygtukais.

Kaip keisti gauty praneSimy rodinj

Dabar pameéginsime pakeisti gauty praneSimy aplanko rodini:

1. Bakstelékite piktograma /nbox.

Desiniuoju pelés mygtuku bakstelejus irankiy juosta ir kontekstiniame meniu pasirinkus
Advanced, pasirodys irankiy juosta Advanced. Dabartinio rodinio pavadinimas Messages
(PraneSimai) rodomas jrankiy juostos Advanced iSskleidZiamame rodiniy laukelyje Current View
(Dabartinis rodinys).

2. Bakstelekite rodyklyte laukelio deSingje ir saraSe pasirinkite By Sender (Pagal siuntéjq).

3. Baksteléjus nedideli pliuso Zenkla, esantj informacijos lange, bus atvertas pranesimu,
gauty i§ konkretaus siuntéjo, sarasas.

4. Dar karta bakstelekite rodyklyte i§skleidziamo rodiniy laukelio deSinéje, tik dabar sarase
pazymekite Message Timeline (PraneSimy laiko juosta).

5. Grizkite 1 numatytaji rodini (Messages) ir teskite toliau.

Kaip keisti kalendoriaus rodinj

Taip pat yra ir daug skirtingy kalendoriaus rodiniu: dienos, savaités, ménesio. Sie rodiniai
sudaryti i$ keliy kity rodiniy, naudojamy persijungti tarp dienos, savaités bei ménesio rodiniy.

1. Outlook juostoje bakstelékite piktograma Calendar.

Kalendorius i$ karto pateikiamas dienos rodiniy. Standartingje irankiy juostoje yra keturi
mygtukai: Day (Diena), Work Week (Darbo savaité), Week (Savaite) ir Month (Ménuo).

2. Bakstel¢jus mygtuka Week, rodomas jusy savaités tvarkarastis.



3. Bakstelékite mygtuka Month ir pamatysite ménesio programa (iSnyks uzduociy sarasas,
kury galite matyti rodiniy Day, Work Week ir Week apacioje deSinéje).
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4. Bakstel¢jus mygtuka Work Week, pasirodys darbo savaités tvarkarastis (be savaitgaliy).
5. Bakstelékite mygtuka Day, ir bus pateiktas pazymétos datos kalendorius.
6. Dabartinés datos dienotvarke pamatysite, baksteléje¢ mygtuka 7oday.

Kaip pridéti nuorody | Outlook juostq

Per nuoroda My Computer, esanCia grupe¢je Other Shortcuts, galite pasiekti kiekviena
aplanka ir faila savo ir kituose vietinio tinklo kompiuteriuose. Daznai kreipiantis i tam tikrus
objektus, pravartu susikurti ju nuorodas Outlook juostoje, kurioje prireikus galite kurti net naujas
grupes.

Kaip Outlook juostoje sukurti naujq grupe

Outlook juostoje galima sukurti nauja grupe. Ja kurkite taip:

1. DeSiniuoju pelés mygtuku bakstelékite Outlook juosta.

2. Kontekstiniame meniu pasirinkite 4dd New Group (Pridéti nauja grupe). Dabar Outlook
juostos apacioje pamatysite papildoma nuorody mygtuka New Group (Nauja grupé).

3. Iveskite norima pavadinima ir paspauskite klavisa Enter — Outlook sukuria grupg nauju
pavadinimu.

4. Bakstelékite nauja grupe, kurioje kol kas néra jokiuy piktogramuy.

Kaip sukurti naujq nuorodq Outlook juostoje

Zinoma, naujoje grupéje galima sukurti nuoroda i nauja aplanka:

1. Informacijos lange bakstelékite nauja aplanka.

2. QOutlook lauke bakstelékite nauja grupe.

3. Paskui aplanko piktograma i$ informacijos lango ekrano desin¢je nuvilkite i Outlook
lauka ekrano kair¢je ir ja padékite po grupés pavadinimu.

Kaip panaikinti nuorodas ir grupes

1. Outlook juostoje deSiniuoju pelés mygtuku baksteléekite nuoroda.

2. Kontekstiniame meniu pasirinkite punkta Ramove from Outlook Bar (Panaikinti i$
Outlook juostos).

Dabar jums reikés patvirtinti panaikinima, dialogo lange bakstelint mygtuka Yes.



Outlook Today

Norédami pamatyti bendra susitikimy, uzduoc€iy ir neskaityto el. pasto apzvalga, pasitelkite
rodini Outlook Today:

1. Outlook juostoje bakstelékite grupe Outlook Shortcuts.

2. Bakstelékite piktograma Outlook Today.

2. Bendravimas

Siame skyriuje aptarsime kelias Outlook funkcijas, susijusias su el. pastu, todél turime
persijungti { kita rodinj.

1. Paleiskite Outlook, jeigu dar to nepadaréte.

2. Outlook juostos grupéje Outlook Shortcuts bakstelékite Inbox.

Kaip kurti praneSimus

Ketindami i$siysti praneSima, pirmiausia atidarote tus¢ia forma, kurioje iSdéstote tam tikra
informacija. Si forma siunc¢iama el. paSto tarnybai, o i§ ten ji patenka asmenims, kuriems yra
adresuota.

Nauja pranesima kurkite taip:
1. Irankiy juostoje bakstel¢kite mygtuka New Mail Message (Naujas pranesimas).

% | Untitled - Message (HTML)

File Edit Wiew Insert Format Tools  Actions  Help -
2 options... 7 »

Subject: |

5 pav. Outlook — el. paSto redaktorius

2. Lauke 7o (Kam) jraSykite gavéjo varda (galite paméginti jraSyti savo varda). Jeigu jums
neaiskus tikslus vardo uzra§ymas, mygtuku 7o Outlook galite atverti adresy knyga, kurioje
pazymeékite savo praneSimo gaveéjus (skaitykite kita pastraipa).

Jeigu pranesimas skirtas ne vienam gavéjui, kiekviena varda atskirkite kabliataskiu arba tarp
vardy paspauskite klavisa Enter.

3. Norédami kam nors iSsiysti pranesimo kopija, adresato varda iraSykite kopijos lauke
Cc (Carbon Copy). Galite i8siysti ir slapta kopija, iraSydami varda i lauka

Bcc (Blind Carbon Copy).

Cc ir Bec skiriasi tuo, kad prie lauke Cc jraSytam adresatui bus iSsiysta praneSimo kopija, o
jo varda matys ir kiti, gave jlisy praneSima. Jeigu varda irasSysite lauke Bcc, kopija bus iSsiysta
nurodytam gavéjui, bet jo vardo kiti jisy praneSimo gavéjai nematys.

Pasirinkite View 2Bcc Field (Rodyti 2 Bcec laukas), jeigu Bece laukas yra nematomas.

4. Lauke Subject (Tema) jveskite pranesimo tema.

5. Zinute parasykite pranesimo lauke.

6. Baksteléjus mygtuka Send, praneSimas iSsiunc¢iamas.



Adresavimas

Outlook, pasitelkus adresy knyga, galima siysti Zinutes vienam asmeniui, jvairiems
asmenims arba visai asmeny grupei. Adresu knyga sudaro vartotojai, skirstymo sarasai ir bendrieji
aplankai, i kuriuos siunc¢iami praneSimai.

Adresy knyga

Dabar, norédami is$siysti praneSima vienam jusy kolegai, paméginsime pasinaudoti adresy
knyga:

1. Bakstelékite mygtuka New Mail Message arba pasirinkite komanda File 2New >Mail
Message.

2. Baksteléjus mygtuka Tepatveriama adresy knyga.

3. Sarase Show names from the (Rodyti vardus i§) pazymékite norima adresy sarasa.

4. SaraSe pazymekite reikiamus asmenis ir juos perkelkite { gavéjy saraSo dialogo langa
desingje, baksteledami mygtukus 7o ir Cc (galbiit ir mygtuka Bcc).

5. Baksteléjus OK, dialogo langas uzveriamas.

6. IraSykite tema (Subject) ir trumpa Zinutg dialogo lange.

7. Bakstelékite mygtuka Send.

8.
Adresatai

Tarkime, kad jiis dalyvaujate vidiniame bendrovés projekte ir turite daznai siysti Zinutes
kitiems projekto grupés zmonéms, todél pasinaudokite adresaty aplanku, kuriame taip pat galite
kurti ir skirstymo sarasa.

Kaip adresaty aplankq papildyti

Asmentis i$ adresy saraSo perkelkite | adresaty aplanka taip:

Irankiy juostoje bakstelekite mygtuka Address Book.

1.  Dialogo lange Address Book pasirinkite komanda Tools 2Options ir sarase Keep
Personai Addresses (Laikyti asmeninius adresus) pazymeékite Contacts.

Jeigu savo adresus norite laikyti asmeninéje adresy knygoje, pazymékite Private Address
Book ir tgskite toliau.

2. Bakstel¢je OK, sugrisite i dialogo langa Address Book.

3. Lauke Show Names from the pazymékite adresy sarasa, 18 kurio ketinate perkelti asmenis
(pvz., pasaulinis adresy sarasas).

4. SaraSe po lauku Type Name or Select from List (IraSykite varda arba pazZymeékite sarase)
pazymékite asmenis, kuriuos perkelsite | adresaty knyga

5. DeSiniuoju pelés mygtuku bakstelekite pazymetus asmenis ir kontekstiniame meniu
pasirinkite komanda Add to Personai Address Book (Perkelti { asmening adresu knyga). Pazyméjus
tik vieng asmenj, atveriamas dialogo langas Contacts, kuriame galite jvesti papildoma informacija
apie asmeni, paskui bakstelékite mygtuka Save and Close (Irasyti ir uzdaryti).

6. Kiekvienam asmeniui, kurj norite perkelti | adresaty knyga, pakartokite 5 ir 6 veiksmus.

7. Baikite darbg komanda File 2 Close.

Adresaty ir asmeninés adresy knygos naudojimas

Norédami iSsiysti praneSima, bakstelékite mygtuka To ir rinkités adresus i$ adresaty arba
asmeninés adresy knygos:

1. Bakstelékite laukeli Show Names from the ir saraSe pazymeékite Contacts arba Private
Address Book. Bus rodomi tik tie asmenys, kuriuos perkéléte 1 dabartinj sarasa.

2. Pazymekite reikiamus asmenis ir bakstelékite mygtuka 7o. Baksteléjus mygtuka OK,
dialogo langas uzveriamas ir griztama | pranesimo langa.
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Kaip pridéti el. pasto adresq
Adresaty knygoje gali biiti asmeny ar istaigy, naudojanciy ir kita pasto sistema,
nes daznai kontaktai su §iais Zmonémis ar {staigomis palaikomi per Interneta.
Toliau paaiskinsiu, kaip sukurti nauja adresata su el. paSto adresu:
1. Irankiy juostoje bakstelékite mygtuka Address Book. Atveriamas dialogo langas Address

Book.
Eile Edit Wiew Insert Format Tools  Actions  Help -
Hsveandcose [ & 00 v @ 3o -
Geners| | ] Details 1 Activities ] Certificates ] All Fields ]
g Fulpare.. [ @Eus\ness ~
Job title: —————— Home ﬂ —
Company: — Business Fax ﬂ’i
File as: [ =l Mobile ~
@ Address... E-ma\\ ~| =]
Business ﬂ % Display as! [
'f‘. web page address: ‘
I This is the mailng address q
IM address: ‘
contacts... | | categores... | [ Eivate |

6 pav. Dialogo langas Contacts.

2. Baksteléjus mygtuka New Entry (Naujas irasas), atveriamas dialogo langas New Entry.

3. Sarase Select the entry type (Pazyméti iraSo tipa) pazymekite elementa New Contact
(Naujas adresatas).

4. Patikrinkite, ar dialogo lango apacioje sarase pazymétas laukelis Contacts, ir
bakstelé¢kite OK.

5. Dialogo lange Contacts iveskite informacija apie norima asmeni ar istaiga. Galima jvesti
asmens varda ir jo el. pasto adresa arba papildoma informacija-

6. Bakstelejus mygtuka Save and Close, dialogo langas uZ veriamas.

PraneSimy siuntimas

Programa Outlook leidZzia naudotis jvairiomis siunciamy praneSimy pristatymo ir marsruto
sekimo parinktimis, kurias aptarsiu kitame skyrelyje.

Kaip sekti iSsiysty praneSimy marsrutq

Norédami jsitikinti, kad jusuy el. pastas nu¢jo saugiai, arba tiesiog norédami zinoti, kada
gavéjas perskaito jlisy praneSima, galite nurodyti, kad jus informuoty, kai gavéjas gauna jlisy
praneS$img ir/arba kada tas praneSimas atveriamas.

Gana paprasta naudotis registruotuoju pastu svarbiems laiSkams siysti, nes galima patikrinti,
ar gavéjas gavo jusy svarby pranesima, ar ne.

1. Sukurkite nauja pranesSima ir tinkamai ji uzpildykite.

2. Bakstelékite mygtuka Options.

3. Lauke loting and Tracking Options pazyméjus Request a delivery receiptfor this
message (Sio prane§imo pristatymo patvirtinimas), jums bus praneita, kai gavéjas gaus jisu
pranesima.

4. Kai lauke Voting and Tracking pazyméta Recjiiest a read receiptfor this message (Sio
prane$imo perskaitymo patvirtinimas), gausite patvirtinima, kad gavéjas jlisy praneSima perskaité.
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Pranesimo svarba

Galima adresatui nurodyt jisu praneSimo svarbuma. Numatyta, kad visi praneSimai
siunfiami paprasti, taciau raudonu Sauktuku abonento dézutéje galite nurodyti, kad praneSimas
svarbus, arba mélyna zemyn nukreipta rodykle - kad nesvarbus.

Svarba nurodoma taip:

» [rankiy juostoje bakstelekite mygtuka Priority: High, nurodydami, kad praneSimas labai
svarbus.

* [Irankiy juostoje bakstelékite mygtuka Priority: Low, nurodydami, kad praneSimas
nesvarbus.

Kaip atSaukti pranesimq

PraneSima, kol gavéjas dar jo neatveré, galima atSaukti. Tada ji galima panaikinti arba
pakeisti kitu. PraneSimas atSaukiamas taip:

1. Outlook juostos grup¢je My Shortcuts bakstelekite piktograma Sent Items - atveriamas
i$siysty pranesimy aplankas.

2. Dukart bakstel¢jus praneSima, kuri norite atSaukti arba pakeisti kitu, atveriama
pranesimo kopija.

3. Pasirinkite komanda Actionsy 2 Recall This Message (Veiksmai | AtSaukti §i prane§ima).
Dabar turite nurodyti, ar panaikinti, ar pakeisti dabartini praneSima gavéjo gauty praneSimy
aplanke.

4. Pirmiausia bakstelékite norima parinkti, o paskui - OK. Pasirinkus Delete unread copies
of this message (Panaikinti neskaitytas $io praneSimo kopijas), praneSimas tiesiog iStrinamas. Kita
vertus, kai pasirenkate Delete unread copies and replace with new message (Panaikinti neskaitytas
kopijas ir pakeisti nauju), galite ta pranesima pakeisti ir iSsiysti kaip iprasta, o tada vél uzdaryti.

Atsakymas | praneSimus
Tikriausiai jau gavote daugybg praneSimuy, su kuriais galite elgtis jvairiai:
» Perskaityti ir parasyti atsakyma.
* Persiysti kitiems.
» Perkelti arba nukopijuoti i kitus aplankus.
» Panaikinti.

Kaip skaityti paStq ir atsakyti

Norima skaityti praneSima dukart bakstelékite. Perskaite bakstelékite mygtuka Close, esanti
virSutiniame deSiniajame lango kampe. Jeigu prie praneSimo pridéta faily arba kity objekty, juos
irgi galima dukart baksteléti ir perzitiréti.

Jei norite atsakyti, darykite taip:

1. Gauty praneSimy aplanke dukart bakstelékite pranesima, i kuri norite atsakyti (jeigu
negavote jokio laiSko, i§siyskite praneSima sau).

2. Baksteléje mygtuka Reply (Atsakyti), iSsiusite atsakyma siuntéjui, o baksteléje

mygtuka Reply to All (Atsakyti visiems), iSsiusite atsakyma visiems adresatams 1§ laukeliy
To ir Cec.

3. Parasykite atsakyma ir, jeigu reikia, iStrinkite gauto praneSimo teksta.

4. Baksteléjus mygtuka Send, bus iSsiystas atsakymas.

PASTABA Norint atsakyti, visi nebitina atverti gauta praneSima. Galima pazyméti gauty
pranesimy aplanke pranesima ir i$ karto spausti irankiy juostos mygtuka Reply.
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Pasto persiuntimas kitiems

Daugeli gauty pranesimy galite taip pat persiusti (jei jie neantspauduoti), kad kiti asmenys
galéty aptarti pasitlyma ir t.t.

1. Gauty praneSimy aplanke dukart bakstelekite pranesima (jeigu negavote jokio
praneSimo, i$siyskite laiska sau).

2. Bakstelekite mygtuka Foward (Persiysti).

3. Laukelyje 7o iveskite gavéjo varda arba ji pasirinkite i§ adresy saraso.

4. Jeigu turite, jrasykite savo pastabas.

5. Bakstelejus mygtuka Send, praneSimas bus persiystas.

PASTABA Persiunciamo praneSimo atverti nereikia, nes galima ji baksteléti informacijos
lange ir paskui baksteléti mygtuka Forward.

PraneSimy biisena
Zenklinimas véliavéle

Biisena Zymima taip:

1. Dukart bakstelékite vieng i§ gauty praneSimy.

2. Irankiy juostoje bakstelékite mygtuka Follow Up.

3. Pazymekite reikiama praneSima atsidariusiame dialogo lango saraSe Flag for Follow Up
ir, jeigu reikia - data ir laika saraSuose Due by.

4. Baksteléjus OK, dialogo langas uZveriamas. Dabar bet kada matysite dabartinio
prane$imo bliseng pranesimo virsuje.

5. PraneSimui uzdaryti virSutiniame deSiniajame lango kampe bakstelekite mygtuka Close,
o skiltyje Flag Status (Véliavéles biisena) matysite maza raudong véliavélg.

Kaip Zyméti perskaitytq ir apdorotq praneSimq

Apdorota praneSima paZymeékite taip:

1. Dukart bakstelékite pranesima.

2. [Irankiy juostoje bakstel¢kite mygtuka Follow Up.

3. Pazymeékite laukeli Completed.

4. Bakstelekite OK dialogo langui uzverti; dabar praneSimo virSuje pamatysite, kad
pranesSimas paZymeétas kaip apdorotas.

5. PraneSima uZzdarykite, baksteléedami mygtuka Close virSutiniame deSiniajame lango
kampe, tada skiltyje Flag Status pamatysite maza pilka véliavéle.
Pasto perkélimas arba kopijavimas | kitus aplankus

Pranesimus galima perkelti arba kopijuoti i kitus aplankus, sukurtus savo reikméms.

Sukurti aplanka:

1. Pasirinkite komanda File > New =2 Folder.

2. TraSykite naujo aplanko pavadinima.

3. SaraSe Folder contains (Aplanke yra) pazymekite Mail and Post Items (PaStas ir pasto
elementai).

4. SaraSe Select where to place the folder (Pazyméti, kur patalpinti aplanka) pazymékite
vieta, kurioje kursite nauja aplanka.

5. Baksteléjus OK, aplankas bus sukurtas.

6. Outlook pasiteiraus, ar pridéti nuoroda | nauja aplanka Outlook juostoje. Jeigu taip,
bakstelekite mygtuka Yes.

Nuoroda bus idéta i grupe My Shortcuts.
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Pranesimy perkélimas ir kopijavimas

PraneSimus galite perkelti arba kopijuoti i nauja aplanka:

1. Pazymeékite pranesima, kuri ketinate perkelti / kopijuoti.

2. Pasirinkite komanda Edit »Move to Folder (Perkelti | aplanka) arba Edit> Copy to
Folder (Kopijuoti i aplanka).

3. Dialogo lange Mové Items>Copy Items (Perkelti elementus/Kopijuoti elementus)
pazymékite nauja aplanka ir bakstelékite OK Taip pat pagrindinius aplankus galima atidaryti,
bakstelint viena i$ pliuso zenkly.

Rodiniai

Outlook ieskoti savo duomeny arba juos sisteminti galima jvairiai:

* Ieskoti tam tikry elementy.

* Rasiuoti elementus pagal skilties antraste.

* Elementus grupuoti, jungiant skirtingas skilties antrastes.

* Filtruoti elementus, kuriems pritaikomi tam tikri kriterijai.

Nustatyta informacijos rodymo biida aplanke galima jrasyti kaip rodini, kuris taikomas tik
dabartiniam aplankui arba visiems aplankams.

Kaip ieSkoti

Norédami rasti elementa, kuriame yra tam tikri Zodziai, pasitelkite komanda Find (Rasti).

Ieskokite taip:

1. Atidarykite aplanka, kuriame bus ieSkoma (pvz., gauty praneSimy aplanka), ir irankiy
juostoje bakstelékite mygtuka Find.

2. Lauke Look for (Ieskoti ko) jrasykite ieSkomus Zodzius. Jeigu ketinate ieSkoti kitame, ne
dabartiniame aplanke, sarase Search in pazymékite norima aplanka.

3. Paieskai pradéti bakstelekite Find now (Rasti dabar). Pasibaigus paieskai, pamatysite
elementy, atitinkanciy jusy kriterijus, sarasa.

4. Irankiy juostoje vel baksteléjus mygtuka Find, paieska bus baigta.

RiuSiavimas

Norédami surtiSiuoti aplanky turini, nuosekliai atlikite tokius veiksmus:

1. Pasirinkite komanda View 2>Cunent View >Customize Current View ir pazymekite Sort
(Rasiuoti).

2. Pazymekite skilti (-iS), pagal kuria risiuosite. Visai paprasta risiuoti pagal skilti, kurios
nerodo informacijos langas.

Grupavimas

Jeigu savo informacija norite susisteminti pagal viena arba kelias kategorijas, galite ja
grupuoti pagal, pvz., bendrovés pavadinima, skyriy ir produkto pavadinima.

Grupuojama taip:

1. Atidarykite aplanka, kuriame grupuosite.

2. Pasirinke komanda View = Current View > Customize Current View, pazymékite
Group by (Grupuoti pagal).

3. Pazymekite pirma kategorija, pagal kuria grupuosite, ir nurodykite, kaip grupuosite -
pagal abécéle nuo A iki Z ar atvirks¢iai - nuo Z iki A.

4. Toliau sisteminti elementus galima kituose laukuose Then by (Tada pagal).
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* Ascending
" Descending
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Cancel

Clear all
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Then by

mone) K3l
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| =

-

Select available figlds From: Expand/collapse defaults:

j |.0.s last viewsed

|Frequently-used fields

[
7 pav. Gauti praneSimai pirmiausiai rii§iuojami pagal gavimo laika maz¢jancia tvarka, o
paskui — pagal tema abécélés tvarka

Pasirinktos informacijos filtravimas

Jeigu aplanke norite matyti tik tam tikra informacija, temas, failus arba praneSimus,
informacijai paslépti ir kt. naudokite vadinamaji filtra, kuriam nereikia specialiy salygu.

Filtra kurkite:

1. Pasirinke komanda View 2Current View 2 Customize Current View, pazymékite Filter.

2. lveskite arba pazymékite salygas, kurios bus taikomos filtrui.

Filtrui pasalinti bakstelékite mygtuka Clear All (Pasalinti visa).

3. Dialogo langa ir dialogo langa View Summary uzverkite mygtuku OK.

Filter 3
Messages | are Cheices | Advanced | 0L |
Search For the word(s): |hudget\ j
In: |subiect Field only j
From... [
Sert To... [
[~ Where I.am: | J
Tins: [rone = E
OK I Cancel ‘ Clear Al |
8 pav. Dialogo lange Filter nustatoma tam tikra informacija, pagal kurig bus rodomi
pranesimai.

Gauty praneSimy aplanko sisteminimas

Outlook galima sisteminti gauty praneSimy aplanko ir kity aplanky turini iprastu ir
struktiiriniu budu. Su funkcija Organize lengvai nustatysite taisykles, pakeisite rodinius ir
susidorosite su nepageidaujamu pastu - Siukslémis.

1. Irankiy juostoje bakstelékite mygtuka Organize.
2. Pasirinkite viena i8 Siy parinkciy:

« Using folders (Naudojant aplankus) Cia kuriami nauji aplankai, prane§imai perkeliami {
kitus aplankus ir nustatomos taisyklés, pagal kurias automatiskai jraSomi vartotojo nustatyty
siuntéjy pranesimai | tam tikrus aplankus.

« Using Colours (Naudojant spalvas) Cia galima pritaikyti spalvas dabartinéms ir bisimoms
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zinutéms pagal siuntéjus, o visus pranesimus, siunc¢iamus tik jums, nuspalvinti viena spalva.

+ Using Views (Naudojant rodinius) Cia greitai persijungsite tarp rodiniy.

« Junk e-mail (Pasto Siukslés) Cia galima panaikinti jkyrias pasto $iuksles, pvz., reklama.
Joms galima pritaikyti spalvini koda, perkelti i kita aplanka arba nedelsiant iStrinti.

3. Organize uzdarykite, dar karta baksteléedami mygtuka Organize.

Kitos praneSimy parinktys

Siunciant ir gaunant praneSimus, galima naudoti kitas parinktis:

» Pridéti failus ir kitus objektus.

* Pridéti jvairius balsavimo mygtukus.

* AutomatiSkai pridéti parasa.

* Automatiskai naudoti asistentus praneSimams rtsiuoti ir tvarkyti

Faily ir objekty pridéjimas

Norédami iSsiysti failus, praneSimus arba kitus objektus, iraSytus kompiuteryje, ta galite
padaryti per paprasta el. laiSka. Prie jo galima pridéti pacius duomenis, nuorodas i duomenis arba
piktogramas.

Failai pridedami taip:

1. Bakstelekite mygtuka New Mail Message (jeigu dar to nepadaréte).

2. lveskite gavéja, tema ir, jeigu reikia, nedidelg zinutg gavéjui.

3. Irankiy juostoje bakstelekite mygtuka Insert File (Pridéti faila).

4. Dialogo lange Insert File bakstelékite mygtuko Insert rodykle ir i§ saraso pasirinkite.
Galimos tokios parinktys:

* Insert (Iterpti) Pridedamas originalaus formato failas.

+ Insert as text (Iterpti kaip teksta) Pridedamas failas kaip tekstas.

5. Bakstelekite OK.

Zinoma, prie to pa¢io prane$imo galima pridéti ir jvairius failus, kiekvienam failui, kurj
norite prijungti, kartojant 3-5 veiksmus arba i§ karto pazymint daug faily (zymédami laikykite
nuspaudg klavisa Ctrl).

6. Dabar praneSima iSsiyskite kaip iprasta - bakstelékite mygtuka Send.

Kaip kurti parasa

Parasas kuriamas taip:

1. Pasirinkg komanda Tools > Options,

bakstelekite skirtuka Mail Format (Pasto formatas). Be vieno arba daugiau paraSy
prijungimo, galima nurodyti, kokiu formatu paraSyti praneSimai ir kaip turéty atrodyti ,,raSomasis
popierius".

2. Bakstelékite mygtuka Signatares (Parasai), paskui - New (Nauji).

3. Lauke Enter a name for your new signatare ([vardykite savo nauja parasa) irasykite
paraso pavadinima, pazymeékite Start with a blank signature (Pradéti nuo tuS€io paraso) ir
bakstelekite mygtuka Next.

4. Lauke iveskite paraSa; Srifta galite pakeisti su mygtuku Font, o pastraipos savybes - su
mygtuku Paragraph ir t.t..

5. Bakstel¢jus mygtuka Finish, paraSas bus sukurtas, o bakstel¢j¢ mygtuka OK grisite |
Outlook.
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4. Asmeninis planavimas

Su Microsoft Outlook taip pat galima tvarkyti asmeninius tvarkaraS$€ius ir asmening
informacija, kaip antai susitikimus, uzduotis, projektus, rysius ir 1.1.

Kitaip negu jprastas popierinis kalendorius, Outlook gali:

* Perzvelgti tvarkarasti ivairiai - kasdien, kas savaite, karta per ménesi arba kaip uzduociy
sara$a, reikalinga informacija ivedant tik viena karta.

* Visus savo adresatus ivesti i duomeny bazg ir ja naudoti prisijungti, adresams rasyti ir kt.

» Priskirti savo susitikimus ir projektus adresatams ir sekti projekto eiga.

*  Susitikimus nustatyti automatiskai.

* Qutlook naudoti vietiniuose tinkluose ir leisti kitiems vartotojams prieiti prie
informacijos. Vedliui arba kolegai galima nurodyti, kad tvarkyty jiisy tvarkarasti ir kad jis bty
pasiekiamas i§ bendrovés biuro ir i§ namy.

+ [vairiai spausdinti savo informacija, adresatus, susitikimus, projekto buisena ir t.t.

* Keistis informacija su, pvz., Palm ir kitais kiSeniniais kompiuteriais — net isikelti
informacija i specialiai sukonstruota rankinj laikrodi 7imex.

» Keisti kalendoriaus informacija per vCalendar ir iCalendar.

Naudojant Outlook darbams planuoti, Outlook juostoje galima naudoti dvi piktogramas:

» Kalendoriaus (Calendar) piktograma susitikimams ir kitiems jvykiams tvarkyti.

* UZduociy (Tasks) piktograma, skirta uzduotims ir projektams skirti bei perzitiréti.

Susitikimai ir jvykiai

Outlook juostoje baksteléjus kalendoriaus piktograma Calendar, persijungiama |
kalendoriaus rodini, atveriama tam tikros dienos tvarkarastis, kurj jau matéte.

VirSutiniame deSiniajame kampe yra kalendorius Date Navigation, atliekantis kelias
funkcijas. Pagrindiné jo funkcija - pateikti glausta dabartinio ménesio dieny apzvalga, taciau su Sia
funkcija galima ir persijungti tarp daty. Norédami pereiti | tam tikra data bakstelékite ja arba
bakstelekite viena i dviejy rodyklycCiy Salia ménesio pavadinimo, kad pereituméte | ankstesnj arba
kita ménesi. Bakstel¢jg savaités skaiCius kairiojoje daty pus¢je, pereisite | nurodytos savaités rodini,
o norédami persijungti { ménesio rodini, virSuje bakstelékite savaités dienas.

Kaip kurti

Kalendoriuje yra dvi kategorijos:

» Susitikimai Tai susitikimai, su data ir laiku. Jie trunka apibréZta laika ir kuriami kaip
nuolat pasikartojancios uzduotys, taigi pirmadienio susitikimas gali vykti kiekviena pirmadieni
(kada parrengti pirmadienio susitikima?). Outlook automatiSkai gali priminti jisy susitikimus,
atverdama dialogo langa, likus tam tikram laikui iki susitikimo.

* [vykiai Cia jvedami tvykiai, turintys fiksuota data, bet neapibrézta laika. Jeigu, pvz.,
savaitei vaziuojate i pardavimy kongresa, sukurkite penkiy dieny ivyki, panasiai kurkite ir atostogas
ir t.t. Qutlook galima sukurti ir periodinius ivykius, kurie nuolatos kartojasi.

Kaip matote srityje, einancioje po Date Navigation, uzduotis galima taip pat {vesti
kalendoriuje, nepersijungiant { uzduociy rodini.

Susitikimo kairimas (trumpas)

Outlook susitikimai kuriami jvairiai. AiSkiausias budas:

1. Suraskite data, kuria norite matyti kalendoriuje, ir paZymeékite laikotarpi, kurio jums
reikia.

2. Apibrézkite susitikima, paspauskite klaviSa Enter, ir susitikimas bus sukurtas.
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Susitikimo kiirimas (iSsamus)

Susitikimas detaliau kuriamas taip:
1. Dar karta pazyméjus reikiama laikotarpi ir baksteléjus mygtuka New Appointment

(Naujas susitikimas), atveriamas dialogo langas Appointment.
2. Laukelyje Subject jraSykite apibrézima ir paspauskite tabuliacijos klavisa pereiti 1 kita

laukelj.

3. Jeigu norite, laukelyje Location (Vieta) galite jvesti susitikimo vieta ir t.t.

4. Prireikus galima pakeisti pradzios ir pabaigos laika.

5. Susitikimui priminti pazymeékite Reminder (Priminimas) ir nurodykite, kiek laiko likus
iki susitikimo tas priminimas turi pasirodyti.

Dabar Outlook automatiSkai primins apie susitikima, parodydama pranesima, taciau tuo
metu, kai turi pasirodyti priminimas, Outlook turi biiti paleista.

6.  Sarase Label - tai nauja Outlook 2002 savybé - savo susitikimams galite priskirti

tvairias fonines spalvas priklausomai nuo susitikimo tipo.
7. Irankiy juostoje bakstel¢jus mygtuka Save and Close, dialogo langas uzveriamas.

B3 Intial discussions about Budget 2003 - Appointment Q@@l

File Edt Wew Insert Format Tools  Actions  Help
[EsaveandClose & Il | 3 Recwrence.. T 3 ¥ @ .
Appointrment 1 Scheduling 1

&This appointment occurs inthe past,

Subject: |Int\al discussions about Budgst 2003

Location: | | I This is an online meeting using:
Etart tme:  [Stz003.01.18 x| [ion | T alday event
R4l e |

End time: [t 20030118

Z}f I Reminder: [15 minutes j @ Shiow b as: ’i Busy =] Labet: [T rone =

Contacks... | Categaoties. .. Private [

9 pav. Pasirinktas laikotarpis pakeiiamas i pradzios ir pabaigos laika, o laukelyje subject
ivedamas susitikimo apibtidinimas.

Ivykio planavimas

1. Pasirinkite komanda Actions ?New All Day Event (Naujas visos dienos ivyKkis).

2. Uzpildykite dialogo langa.
3. Bakstel¢jus Save and Close, ivykis bus sukurtas.
Ivykius matote ivairiy laiko tvarkarasciy virSuje, o tikroje dienotvarkéje jie nebus rodomi.

UZduotys ir projektai

Kaip kurti uZzduotj

Uzduotys kuriamos taip pat, kaip ir susitikimai. Pvz., bakstelékite kuriame nors uzduociy
lauko jvesties laukelyje ir {veskite uzduoties apibrézima arba dukart bakstel¢kite vieng i§ laukeliy
apacioje, kad atsiverty dialogo langas, kuriame galite ivesti daugiau detaliu.

UZzduotys yra patogios jvairioms uzduotims ir pradétiems projektams tvarkyti.

Svarbiausi uzduoties laukeliai:

* Due date (Planuojama ivykdymo data) - ¢ia nurodoma uzduoties pabaiga.

» Start date (Pradzios data) — nurodote uzduoties pradzios data.
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* Reminder (Priminimas) - veikia taip pat, kaip ir susitikimy atveju.
* Date completed (Uzbaigimo data) - automatiSkai jraSoma Siandieniné data, kai paZymite,
kad uzduotis baigta, prireikus galima ivesti kita data.

Prepare Product presentation - Task Q@El
File Edt Wew Insert Format Tools  Actions  Help -
Save and Close B ] <Recurence.. 5 ¥ @.

Task ] Details ]

Subject: [Frepare Product presentation
E Due date: [wore =] Stabus; Mot Started =]

— Statt dake: ’Noneij Priority: ’m % Complete: Wi‘

4 W Reminder: [3t2003.01.18 | [oz:00 | | owner: [unknown

The presentation to be used in week14

Contacts... | | Categories... | | Private |
10 pav. Dialogo lange Task apibrézkite tebevykstancias ir biisimas uzduotis

Didesnés likusios informacijos, kuria rasote, dalies Outlook tiesiogiai nenaudoja, ji yra tik
ta vieta, kur galite {vesti nedideles pastabas, kuriy tikriausiai turite.

Skirtuke Details iveskite ivairias informacijos apie kiekviena uzduoti biisenos smulkmenas.
Taciau svarbu pabrézti, kad $iu duomeny Outlook nepanaudos (iSskyrus laukeli Date completed),
todel jose galima rasyti ka tik nori.

Periodiniai susitikimai, jvykiai ir susirinkimai

Kai susitikimai, ivykiai ir susirinkimai pasikartoja periodiskai, pasinaudokite Outlook
pasirinktimi juos automatiskai kurti su meniu elementais New Recurring Appointment (Naujas
pasikartojantis susitikimas), New Recurring Event (Naujas pasikartojantis ivykis) arba New
Reccuring Meeting (Naujas pasikartojantis susirinkimas), kuriuos rasite kontekstiniame meniu. Jis
atveriamas, deSiniuoju pelés mygtuku bakstelint, pvz., kalendoriy. Galima rinktis ir meniu Actions
elementus.

Paméginkite, pvz., sukurti savaitinj susitikima.

1. Pasirinkite komanda Actions = New Recurring Appointment.

2. Outlook sukuria susitikima, o paskui atveriamas dialogo langas, kurj uzpildykite.

3. Baikite bakstelédami OK, paskui jrasykite susitikimo apibiidinima kaip jprasta.

Appointment Recurrence @E‘
Appointment: time
Start: [06:00 7| end: [oez0 | Duwation: [30 minutes |
Recurrence pattern
" Daily Recur every |1 week(s) on:
* eekly ¥ pirmadienis [ antradienis I trediadienis [ kstvirtadienis
" Monthly [~ penkkadienis [v Zedtadienis | sekmadienis
 Yearly

Range of recurrence

Start: |3t 2003.01.18 j f* N end date
" End after: |10 occurrences
C Endby:  |Pr2003.02.17 =l
23 Cancel ‘ ‘

11 pav. Savaitinis pirmadienio susitikimas

Susitikimy redagavimas

Jeigu keiciasi kuris nors susitikimas, nesunku tai jvesti 1 Qutlook. Greiiausiai pakeisite
susitikimo apraSyma arba laiko parinktj (tos pacios dienos ribose) tiesiog susitikimy kalendoriuje.
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Norédami susitikima nukopijuoti, panaikinti arba perkelti i kita diena, naudokite atitinkamas meniu
Edit (Redaguoti) redagavimo komandas.

ApraSai ir laiko parinktys

Susitikimo aprasSa ir laiko parinktis keiskite taip:

1. Bakstelékite susitikima, kuri norite pakeisti.

2. Pelés zymeklj vilkite per apraSa (laikydami nuspaudg kairijji pelés mygtuka).

3. Iveskite nauja aprasa.

4. Jeigu susitikimas dar aktyvus, pelés Zymekl] nustatykite ant kairiojo susitikimy lango
rémelio (tinkamumo rodiklio). Pelés zymeklis pasikeicia i keturguba rodykle, su kuria perkeliami
susitikimai.

5. Susitikima vilkite aukStyn arba zemyn iki reikiamo pradzios laiko.

6. Velkant virSutini arba apatini rémeli

(pelés zymeklis pasikeicia i dviguba rodykle) galima lengvai pakeisti pazyméto susitikimo
trukmeg.

Susitikimo kopijavimas

Tarkime, kad jus dalyvausite iprastame susitikime kita diena 13 vai. Uzuot kiir¢ nauja
susitikima, galite nukopijuoti jau egzistuojanti:

1. Pazymékite norima susitikima.

2. Pasirinkite komanda Edit > Copy.

3. Persijunkite i kita diena.

4. Pasirinkite komanda Edit >Paste.

Dabar sukiiréte kitos dienos susitikimo kopija.

Susitikimo perkélimas | kitq dienq

Tarkime, kad susitikimas perkeliamas i§ pirmadienio i penktadieni. Savo kalendoriuje
padarykite $tai ka:

1. Pelés zymeklis, nustatytas susitikimo tinkamumo rodiklio kairéje, pasikeicia i keturguba
rodyklg.

2. Date Navigator susitikima vilkite | kita diena (daty sarasas virSutiniame deSiniajame
dieny kalendoriaus kampe).

Dabar susitikimas perkeltas, tai galite patikrinti, persijungdami { nauja data, kur ir
pamatysite savo susitikima.

Adresatai

Kad asmeninis tvarkarastis pasisekty, reikia mokéti tvarkyti visus asmenis ir bendroves, su
kuriomis nuolatos palaikote ry$ius. Ir vél jums padés Outlook 2002.

Adresaty aplanke laikoma jusuy el. pasto adresy knyga ir duomenys. Adresaty aplanka
naudokite el. paSto adresams, telefono numeriams ir papildomai informacijai, susijusiai su
adresatais, kaip antai gimimo arba vestuviy dienos, laikyti. Bet kuri Outlook elementa susiejant su
adresatais, daug lengviau perzvelgti veikla, susijusia su adresatu.

Kaip kurti adresatus

Adresatus kurkite taip:

1. Grupéje Outlook Shortcuts bakstelékite piktograma Contacts.

2. [rankiy juostoje bakstelekite mygtuka New Contact.

3. Atsiveérusiame lange iveskite reikiama informacija.

Lange Contacts savo adresata galite susieti su kitais, grupuodami susijusius asmenis. Pvz.,
galima susieti sutuoktinius arba tos pacios bendrovés darbuotojus.
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Spausdinimas
Visus programos sarasy tipus galima iSspausdinti.
» Pasirinkite komanda File > Print.

5. Planavimas vietiniame tinkle

Outlook naudojant vietiniame tinkle, atsiveria daugybé naujy galimybiu:

* Su funkcija Schedules (Tvarkaras¢iai) tinkle galima planuoti susitikimus su kitais
Outlook vartotojais, taip pat i ju kalendorius automatiskai ivedamas susitikimo laikas ir tuo pat metu
el. pastu siun¢iamos uzklausos.

» Galima leisti kitiems matyti savo kalendoriy, kad jie galéty derinti savo darbotvarkes su
jasu. Si funkcija naudojama, jeigu turite kalendoriaus tvarkymo vedlj arba esate jgaliotas tvarkyti
kity Zzmoniy kalendorius.

* Per tinklag galima pasiekti kity Zmoniy kalendorius, o ir kiti gali prieiti prie jusu
kalendoriaus (jeigu jiems leidziate), tod¢l daug papraséiau rengti susitikimus ir kt. Zinoma,
kalendoriuje gali buti laikomi ir asmeniniai duomenys, kuriy, jei jie pazyméti kaip asmeniniai, kiti
nematys.

Grupiniai tvarkarasciai

Kalendorius turi dienos, savaités arba ménesio rodinius, be to, visas uzimtas ir laisvas laikas
galimas pavaizduoti grafiskai. Jeigu norite, kad jisy arba kity kalendoriai atrodyty taip, pasitelkite
tvarkarasCio sudarymo priemong (Scheduler), galin¢ia palyginti visy reikiamy asmeny
tvarkarascius.

Kaip rodyti savo kalendoriy

Kalendoriaus rodymo btidas nustatomas taip:

1. Persijunkite i kalendoriy, jeigu to dar nepadaréte.

2. Irankiy juostoje Advanced baksteléjus mygtuka Schedules, Outlook atveria tvarkaraSciy
sarasa, kuriame jvairios susirinkimy riiSys pateikiamos skirtingy spalvy skiltimis.

3. Zymekli nustatius ant skilties, bus parodyta papildoma informacija apie konkrety
susitikima.

Kity kalendoriy rodymas

SaraSe A/l Attenders (Visi dalyviai) galite {vesti vardus arba juos pasirinkti i§ adresy saraso,
kaip paaiSkinta toliau:

1. Dialogo lange Scheduling baksteléjus mygtuka Add Others (Pridéti kitus) ir pasirinkus
Addfrom Address Book (Pridéti 1§ adresu knygos), pateikiama kity kalendoriaus vartotoju apzvalga.

2. SaraSe bakstelekite asmens varda, paskui - mygtuka Required (galima baksteléti ir
Optional (Neprivalomas) arba Resources (IStekliai), nurodant, kad asmens dalyvavimas néra
privalomas arba kad tai iStekliai, pvz., susitikimo vieta arba audiovizualiné jranga).

3. Baksteléje OK, grisite | laiko planavimo priemong, kurioje dabar rodomas kiekvieno
asmens laisvas ir uzimtas laikas.

Kaip pareiksti pageidavimg susitikti su AutoPick

Pasitelkus planavimo priemong, patiems nereikia ieSkoti tinkamo susirinkimo laiko, kuris
tikty visiems susirinkimo dalyviams (ir iStekliams), nes ji automatiskai visa tai suderina.

1. Pradekite kaip ir anksCiau, bakstelédami asmenis (ir iSteklius, jeigu ju yra),
dalyvausiancius susirinkime, kad jie biity irasyti | dalyviu tvarkaras¢io sarasa. Planavimo priemoné
automatiSkai parenka tinkama data ir laika.

2. SaraSe Meeting and time bakstelékite laika, nurodydami susirinkimo trukme (skiriasi nuo
laiko, nurodyto sarase Meeting start time), tada suplanuotos valandos bus paryskintos vertikaliu
rémeliu.
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3. Baksteléjus mygtuka AutoPick Next (Automatinis parinkimas kitas), bus pazymétas kitas
galimas laikas.

4. Baksteléjus mygtuka Make Meeting (Sukurti susirinkima), dalyviams sukuriama
pageidavimo susitikti uzklausa.

5. Uzpildykite dialogo langa taip, kaip ir pildomas bet kuris jprastas susitikimo langas.

Jeigu norite, kad dalyviams bty priminta apie susirinkima, pasirinkite Reminder.

6. Irankiy juostoje baksteléjus mygtuka Send, pageidavimo susitikti uzklausa iSsiunc¢iama,
o pats susirinkimas dabar jtraukiamas i jusy kalendoriy.

ISsiuntus pageidavimo susitikti uzklausa, gavéjas gauna praneSima. Gavéjas siuntéjui gali
siysti atsakyma. Jeigu gavéjas sutinka su pageidavimo susitikti uzklausa, tas susirinkimas
automatiskai jtraukiamas i jo kalendoriy.

Atsakyma galima nedelsiant perskaityti gauty praneSimy aplanke:

1. Pirmiausia bakstelékite mygtuka Send/Receive, kad gautuméte visa pasta.

2. Reikia atverti visus atsakymus, kad matytuméte bendra pageidavimo susitikti uzklausos
rezultata.

3. Kalendoriuje dukart bakstelékite susirinkima.

Gauty atsakymy skaic¢ius rodomas dialogo lango virSuje komentary srityje.

4. Bakstelekite skirtuka Tracking. Dialogo lange parodomas dalyviy sarasas ir juy
dalyvavimas bei atsakymai.

5. Prireikus bakstelekite skirtuka Scheduling, tada pamatysite dalyviy tvarkarast, kuriame
yra naujas susirinkimas (tuo atveju, kai jie dalyvauja susirinkime).

Baksteléjus vieng 18 laiko skil€iy, pasirodys susirinkimo aprasas.

6. Dialogo langa vél uzdarykite komanda File > Close.
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